Movavi Picverse
User Guide

Start here:
- Removing trial restrictions
- Erasing objects from photos
- Changing a photo’s background
Table of Contents

Activating Picverse ................................................................. 2
Getting an activation key .......................................................... 3
Activating without Internet ......................................................... 3
Managing subscription ............................................................ 5
Opening images ........................................................................ 6
Zoom and navigation ............................................................. 7
Image adjustments .................................................................. 8
Smart eraser ............................................................................ 11
Changing backgrounds .......................................................... 13
Retouching .............................................................................. 17
Skin smoothing ....................................................................... 18
Wrinkle removal ..................................................................... 18
Blemish removal ..................................................................... 19
Shine removal ......................................................................... 20
Foundation ............................................................................. 21
Blush ..................................................................................... 21
Red eye removal ....................................................................... 22
Eye enlargement ....................................................................... 23
Changing eye color .................................................................. 24
Eyeshadow .............................................................................. 25
Mascara .................................................................................. 26
Eyebrow pencil ........................................................................ 27
Lip color .................................................................................. 28
Teeth whitening ....................................................................... 28
Changing hair color .................................................................. 29
Face slimming ........................................................................... 30
Reshaping tools ........................................................................ 31
Clone stamp retouching ............................................................ 32
Effects ..................................................................................... 33
Crop and rotate ......................................................................... 35
Resizing images ......................................................................... 37
Text .......................................................................................... 38
Saving images ............................................................................ 40
Changing image format ............................................................ 41
File information ......................................................................... 42
Image size and quality ............................................................. 43
Printing images ......................................................................... 44
Program settings ........................................................................ 45
Keyboard shortcuts ..................................................................... 47
Help and support ....................................................................... 47
Supported formats ..................................................................... 47
System requirements ............................................................... 48
Updating graphics card drivers .................................................. 48
How to collect logs ..................................................................... 49
Movavi Picverse

Activating Picverse

How to activate Movavi Picverse

When you first start Movavi Picverse, it will be running in TRIAL MODE. You will be able to save 10 photos with the Movavi watermark. To use the program without trial restrictions, you will need to buy a license and activate Movavi Picverse. If you don't have an activation key yet, click the button below to visit our website and purchase one. Detailed instructions

[Button] Buy Activation Key

Activate the program
1. Launch the program.
2. Under the Help menu, select Activate Software.
3. Copy the activation key from your email and paste it into the activation dialog box.
4. Click Activate.
If you don’t receive your activation key within an hour
• Check the Spam folder of your mailbox.
• Contact support

Activating without Internet access
If the computer you have installed Movavi Picverse to is not connected to the Internet, you can activate the program via email.
See detailed instructions

Movavi Picverse

Getting an activation key

You can purchase an activation key from the official Movavi website or from any of our partners. To purchase a digital copy from the official website, follow the steps below:

Step 1: Go to the purchase page
To open the purchase page for Movavi Picverse:
• In the Activation menu, choose Buy Activation Key, or
• Follow the link below...

Step 2: Choose a license type
• If you plan to use Movavi Picverse at home, click Buy Now on the purchase page to proceed with buying the personal license.
• If you plan to use Movavi Picverse at work, in a government institution, or gain profit in any way, go to the Business license tab on the purchase page.

After that, you will be redirected to an online store depending on your region and the available payment methods. All of our vendor partners are secure and completely safe.

Step 3: Fill in your billing details
1. Choose any of the available payment methods.
2. Fill in the information required on the page.
3. Enter a valid email address. This email will be used to deliver your activation key.

Step 4: Get your activation key
After the purchase has been verified, you will receive a letter containing your activation key. Now you can use it to activate the program.

Activating without Internet access

If you haven’t received your activation key within the hour:
• Check the Spam folder of your mailbox,
• Contact support

Movavi Picverse

Activating without Internet

How to activate Movavi Picverse without Internet access
1. Click the button below to buy an activation key. After the purchase is completed, the key will be delivered to your email inbox. If you already have a key, skip to the next step.

2. Open the program and go to Help > Activate software.
3. Enter your activation key and select the **Activate offline** option. Click **Activate**.

4. In the next window, click **Copy** and transfer this information to a device with an Internet connection.

5. When you have access to the Internet, paste the information you copied into a new email and send it to **reg@movavi.com**. You should receive a reply within an hour. Copy the **activation key** from the reply and transfer it to the computer with Movavi Picverse installed.

6. Return to the offline activation dialog box. If you've closed it, repeat steps 1-3 and enter the **same activation key you used before**. Then, paste the activation key into the box and click **Activate**.
If the activation is unsuccessful

- Make sure that you have entered the activation key correctly. There should be no additional characters or spaces after the last digit.
- Also make sure that the key you used is meant for Movavi Picverse.
- Before attempting to activate, deactivate your antivirus software and firewall.
- Check that your user account has administrator privileges.
- If none of the above solves the problem, email our support team.

Managing subscription

My subscription is expiring
If you see this window, you need to extend your subscription before it expires. To do this, click Renew Subscription.

A web page will open, where you can pay for the license. After the purchase, you can enjoy the full version again! If you don't extend the subscription, the program will stop working in 7 days.

My subscription has expired
If your subscription has already expired, you need to renew it to continue using the program. To renew your subscription, click the Renew Subscription. A web page will open, where you can buy a new subscription. After the purchase, you'll receive the activation key in an email. Click Enter Key.

Copy the key and paste it into the program window. Then click Activate. Done!
Having problems with activation?
• Make sure you have entered the activation key correctly and try again
• Check that you are activating the right application
• Make sure you have administrator rights on your computer
• If you haven’t receive the key within an hour, check the Spam folder of your mailbox

If you have any questions or problems while activating your Movavi software, feel free to contact us and we’ll help you out!
Our email: support@movavi.com
Click here to open live chat
Movavi Picverse

Opening images

How to open images in Movavi Picverse
Drag-and-drop
Find the necessary image in Finder and then drag it right onto the Picverse window.

Open Photo button

Click the Open photo icon in the upper left corner of the window. A Finder dialog box will appear. There, choose the file you want to edit and click Open.
Browse
On the start screen, click the **Browse for Images** button. A **Finder** dialog box will appear. There, choose the file you want to edit and click **Open**.

Recent file
On the start screen, click **Last edited file**. The thumbnail next to it shows which image was opened last.

File menu
Open the **File** menu and select **Open**. A **Finder** dialog box will appear. There, choose the file you want to edit and click **Open**.

See also:
- Saving images
- Movavi Picverse

**Zoom and navigation**

**How to use the navigation controls**
**Zoom**

When you open an image, it will be fitted to the window size. Use the zoom and navigation tools at the bottom of the window to set a comfortable view.

- **Fit to screen** – adjusts the zoom level so that the entire image can fit in the window.
- **Actual size** – sets the zoom level to 100%, displaying the image as it is.
- **Hand tool** – to move an image around while zoomed in, click the hand icon and hold the left mouse button to move the image. Then, click the hand icon again to go back into editing mode. You can also drag the image by holding the left mouse button and `Space` on your keyboard or by clicking both mouse buttons at the same time.

To magnify an image, use the zoom slider at the bottom of the window. You can also zoom in and out using the mouse wheel. When you zoom in or out, the current zoom percentage will be displayed to the right of the navigation controls.

**Navigation**

Now you can sort through entire photo folders and edit their contents on the fly. Use the file navigation buttons at the bottom of the window:

- **Go to the previous image** in the folder.
- **Go to the next image** in the folder.
- **Delete** the current image.
- **Click and hold** to view the original before editing.
- **Click to compare** your working copy with the original image.
- **Click to view all** the images in the folder.

Movavi Picverse

**Image adjustments**

On the right side of the window, click the **Smart Eraser** icon.
Automatic adjustments
For an instant fix, click **AI Adjust**.

The **HDR Lighting** slider automatically adjusts the brightness and contrast, highlighting both dark and light parts of the image. The **Enhance** slider sets the best value for each color correction setting. You can tweak the results using the sliders below. The **Denoise** slider lets you remove any digital noise in the photo.

Photo restoration
Click **AI Adjust** and then click the **Restore** button to start the restoration process. Select the **Colorize photo** option if you also want to colorize your photo.

White balance
White balance tool lets you remove unrealistic color casts so that objects which appear white in person are rendered white in your photo. To use it, click **Color** and then click the color picker icon on the right-hand panel. Click on a color that you want to be considered as white. The white balance will be adjusted automatically.
Manual adjustments
If you need more specific adjustments, use the sliders in the Light, Color, and Detail sections to achieve the necessary result. To reset a slider adjustment, simply double-click it. If you've changed a few values and want to cancel all the adjustments, click the Reset button underneath the sliders.

Brightness
Allows you to change the overall amount of light in the whole image without changing any other parameters.

Contrast
Allows you to change the difference between the lightest and darkest parts of the image. It can help you make the image more vivid, but too much contrast can cause unwanted posterization.

Saturation
Allows you to make the colors richer (positive values) or more subdued (negative values). Settings Saturation to -100 will make the image grayscale.

Exposure
In photography, exposure is the amount of light allowed to reach the camera's sensor, which is usually achieved using a combination of shutter speed, aperture, and lighting. If there is too much light on average, you may lose some details in the dark parts, while the light areas may become 'washed-out', and vice versa. This allows you to imitate a higher or lower exposure as if you set it on your camera when taking the shot.

Highlights and Shadows
These two sliders allow you to make each component more prominent in the image and make the image darker or brighter.

Sharpness
Allows you to sharpen the image. Please be aware that oversharpening an image can add noise.

Details
Allows you to bring out more details in an image.

Blur
Allows you to slightly blur the image to reduce noise or smoothen out defects.

Temperature
Allows you to make the image feel warmer or colder by adding orange or blue color respectively.

Tint
Allows you to add a red or green tone to the image, either for color correction or for an artistic feeling.
Hue
Allows you to change an image’s overall color. Unlike tinting or color temperature (see below), changing an image’s hue will not color the picture in shades of one color. Instead, it will shift all the image’s colors in a given direction.

Adjusting a specific part of an image
If you want to change the color setting only of a specific part of your photo, use the **Selection Tools** on the right-hand panel.

- **Selection Brush.** Select objects freely.
- **Lasso Tool.** Select an object by tracing its outline.
- **Polygonal Lasso Tool.** Select an object by tracing its outline using straight lines.
- **Magic Wand Tool.** Quickly select objects of the same color.
- **Rectangular Marquee Tool.** Select a rectangular part of the image.
- **Selection Eraser.** Deselect areas of the image.

Select the area you want to work on and make the necessary adjustments. The changes will be applied only to the selected area.

Movavi Picverse

**Smart eraser**

**How to erase objects from a photo**

Step 1: Switch to the Smart Erase tab.

On the top side of the window, click the **Smart Eraser** icon.

Step 2: Choose a selection tool
At the top of the tab, choose a tool you're comfortable using.
Use the **Selection Brush Tool** to paint the red selection area freely. The **Brush Size** slider below will set the brush size.

Use the **Magic Wand Tool** to select adjacent areas of uniform color in a single click.

The **Lasso Tool** allows you to freely draw the object’s outline.

The **Polygonal Lasso** allows you to outline the object with straight lines.

Use the **Selection Eraser Tool** to deselect parts of the image. Just like with the brush, you can change eraser size with the slider below. *(The eraser only affects your selection. It does not erase objects in the photo.)*

Use the **Stamp Tool** to select a part of the image to transfer onto another part of the image. You can use the **Clone Stamp Tool** to mask small blemishes or duplicate objects.

**Step 3: Mark unwanted objects**
Using the selected tool, mark the objects you want to delete in the image. As you paint, these objects will be marked with red.

*Tips and hints:*
- If you've made a mistake, use the **Eraser** to deselect parts of the image. Just like with the brush, you can change eraser size with the slider under the tools.
- When selecting people and objects, don't forget about their shadows and reflections.
- If you need to erase several objects, you can select them all at once or erase them one by one.
- To clear all selections from the image, click **Reset Selection**.

**Step 4: Erase**
Click the **Start Erasing** button to begin processing. Please note that erasing objects with high variation values will take slightly longer. If you aren't satisfied with the result, you can click the **Undo** button and adjust your selection or choose a different variation value. Repeat steps 3-5 to remove any other objects you want.
Step 5: Clone retouching (optional)
If there are some more small defects left after erasing, you can manually correct them with the **Clone Stamp** tool. You can select a patch of the image and copy it over the defects.

1. Select the **Clone Stamp** tool.
2. Hold down the `⌥` key and click onto the part of the image you want to clone. Usually, it should be close enough to the blemish so that the copied spot is similar to the original in color and texture.
3. Paint over the blemish with the copied sample. The source will also move as you paint with the stamp to give a more natural look to the edited parts.

[Learn more about clone retouching](http://www.mvans.com)

---

**Changing backgrounds**

**How to erase and change photo background**

Step 1: Open the Change Background tab

On the right side of the window, click the **Change background** icon.
Step 2: Mark the object and background
You can choose between Brush and Lasso for the selection.

Auto Select
If you are working on a photo with people, you can click the Auto Select button to select the silhouettes automatically. You will be able to refine the selection later on Step 2.

Brush
Mark the foreground and background
1. Click the Brush + icon and roughly mark the foreground objects that you want to keep. There is no need to color the entire object, but if the objects have many small details, you may need to add a few extra strokes.

2. Click the Brush - icon and roughly mark the background that you want to remove. Pay closer attention to parts of the background with a similar color or pattern to that of the foreground.

3. If you’ve made a mistake, click the Eraser icon and remove the selection.

Once you’ve marked the foreground and background areas, Picverse will outline the foreground object with a line. Sometimes, you may need to correct this outline by adding a few green or red brush strokes. For higher precision, use a smaller brush size or zoom in on the details.

4. Depending on the amount of detail around the edges of the foreground object, you may want to change how the edges are detected. Try different Boundary Smoothness values to find which works best for your image.
Lasso

1. Click the **Selection Lasso** icon and trace the outline of the object you want to keep.

2. Click the **Extraction Lasso** icon and trace the outline of the areas you want to subtract from the selection.

Use these shortcuts for easier selection:
- **Del** to delete the last or selected point
- **Esc** to delete the outline

Once you've marked the foreground and background areas, Picverse will outline the foreground object with a line.

*Note*: Don't worry if the selection is not perfect; you will have a chance to fix it on Step 2.

Click **Next Step** to continue.

**Step 3: Refine Edges (optional)**
In the next step, you can correct the selection using different tools.

- Use the **Mask Brush** to correct the selected area. **Foreground Mask** adds to the mask; **Background Mask** subtracts from it.

- The **Hair Selection Tool** is made specifically for changing the background on portraits. Hair can be tough to select correctly. This tool does it for you; simply paint along the hair outline to refine the selection.
Click Next Step to continue.

**Step 4: Select a new background**

1. The background will be cut out, and you can proceed to choose the new background.

2. Now, you can choose to leave the background transparent or choose a new background color or image.

**Transparent:**
If you want to keep a transparent background, click the 'transparency' icon to the color palettes' left.

**Grayscale colors:**
To use a standard white, grey, or black background, choose one of the color icons.

**Color picker:**
Use the Color Picker tool to select a color on any image opened on your screen. By clicking a point on an image, you can change the active color to that located under the pointer.

**Custom color:**
To choose a different color, click the arrow on the rightmost color sample to open the palette. Choose a color using the palette or spectrum. You can also set a color using its HTML or RGB code on the right.

**Image:**
To open an image to use as the background, click the Add Image button and select the background you want to use from the library or upload your image. It will then be added as a new background. After that, you can move and resize the foreground objects on the new background. If you switch to color or transparent background, you can later return to using the image by clicking the preview under the Add Image button.

3. If the edges of the foreground object look too sharp, use the Blur Edges slider to blend them with the background.

4. Use the Shift edges slider if you need to shrink or expand the entire selection. This can be useful for objects with a lot of details around the edges.
5. The Adjust colors slider makes the color range of the object more similar to the background. It makes the whole photo look more natural.

Step 5: Move and resize the object
Click and drag your object to move it anywhere you want in the image. Drag the blue circle icons to change the object’s size. To rotate the object, rotate the blue circle on top, beyond the object’s border.

If the object is much smaller than the original image size, you can later crop the image.

Step 6: Apply changes
Finally, click Apply to accept the changes.

If you want to cancel cutting out the background and discard the selection, click Reset.

Movavi Picverse

Retouching

Use the retouching tools to get rid of small imperfections and apply make-up effects to your portraits.

On the right side of the window, click the Smart Eraser icon.

Learn more:
- Skin smoothing
- Wrinkle removal
- Blemish removal
- Shine removal
- Foundation
- Red eye removal
- Eye enlargement
- Eye color
- Eyeshadow
- Mascara
Skin smoothing

How to make skin smoother
Step 1: Choose Skin smoothing from the Skin section on the right-hand panel.

Step 2:
1. Adjust the brush size and its softness using the Brush size and Brush softness sliders.
2. Set the tool intensity using the Smoothing intensity slider.
3. Then paint along the skin to smooth it.

Use the Eraser to remove smoothing from any excess areas.
Tip: you can change the intensity after applying the effect.

Step 3: Click Apply to save the changes. To discard the changes, click Reset.

Wrinkle removal

How to remove wrinkles
Step 1: Choose Wrinkle removal from the Skin section on the right-hand panel.
Step 2:
1. Adjust the brush size and softness using the **Brush size** and **Brush softness** sliders on the right-hand panel.
2. Set the tool intensity using the **Intensity** slider.
3. Then simply paint along the wrinkle to erase it.

Step 3: Click **Apply** to save the changes. To discard the changes, click **Reset**.

See also:
Blemish removal
Movavi Picverse

**Blemish removal**

**How to remove small skin blemishes**

Step 1: Choose **Blemish removal** from the **Skin** section on the right-hand panel.

Step 2: Adjust the brush size using the **Brush size** slider on the right-hand panel. Set the brush size slightly larger than the blemish you want to remove. Then simply click on the blemish to erase it.

Step 3: Click **Apply** to save the changes. To discard the changes, click **Reset**.
See also:
Clone stamp retouching
Movavi Picverse

Shine removal

How to remove skin shine
Step 1: Choose Shine removal from the Skin section on the right-hand panel.

Step 2: Click the Remove Automatically button on the right-hand panel to remove the excess shine from the portrait.

If the program can't recognize the face automatically or you're dissatisfied with the result, you can use the manual mode. Adjust the brush size using the Brush size slider on the right-hand panel. Then simply paint the skin to make it less shiny.

Step 3: Click Apply to save the changes. To discard the changes, click Reset.
How to apply the make-up foundation effect to a portrait

Step 1: Choose Foundation from the Skin section on the right-hand panel.

Step 2:
1. Choose a color and set its intensity using the Color intensity slider.
2. Adjust the brush size and its softness using the Brush size and Brush softness sliders.
3. Then paint along the face to color it.

Use the Eraser to remove any excess color.
Tip: you can change color and its intensity after applying the effect.

Step 3: Click Apply to save the changes. To discard the changes, click Reset.
Blush

How to apply the blush effect to a portrait

Step 1: Choose Blush from the Skin section on the right-hand panel.

Step 2:
1. Choose a color and set its intensity using the Color intensity slider.
2. Adjust the brush size and its softness using the Brush size and Brush softness sliders.
3. Then paint along the cheekbones to color them.

Use the Eraser to remove any excess color.

Tip: you can change color and its intensity after applying the effect.

Step 3: Click Apply to save the changes. To discard the changes, click Reset.

Movavi Picverse

Red eye removal

How to remove the red eye effect from a photo

Step 1: Choose Red eye removal from the Eyes section on the right-hand panel.
Step 2: Click the **Remove Automatically** button on the right-hand panel to remove the red eye effect.

If the program can’t recognize the face automatically or you’re dissatisfied with the result, you can use the manual mode. Adjust the brush size using the **Brush size** slider on the right-hand panel. Set the brush size to slightly larger than the pupil. Then simply click the pupil to remove the red eye effect.

Step 3: Click **Apply** to save changes. To revert changes click the **Reset** button.

Movavi Picverse

**Eye enlargement**

**How to make eyes bigger in a portrait**

Step 1: Choose **Eye enlargement** from the **Eyes** section on the right-hand panel.
Step 2: The face recognition process will start automatically. Wait until you see the “Face(s) recognized successfully” message pop up on top of the image. If there are several faces in the photo, click the one you want to apply the effect. Click the **Enlarge** button on the right-hand panel.

Step 3: Drag the **Intensity** slider to adjust the effect.

Step 4: Click **Apply** to save changes. To revert changes click the **Reset** button.

---

**Changing eye color**

**How to change eye color in a portrait**

Step 1: Choose **Eye color** from the *Eyes* section on the right-hand panel.
Step 2: Choose a color, set its intensity and brush size using the sliders on the right-hand panel. Make sure to set the brush size slightly larger than the iris. Then simply click on the iris to recolor it.

Use the Eraser to remove excess color from the pupil or the surrounding areas. 
Tip: you can change color and its intensity after applying the effect.

Step 3: Click Apply to save the changes. To discard the changes, click Reset.

Movavi Picverse

Eyeshadow

How to apply the eyeshadow effect to a portrait

Step1: Choose Eyeshadow from the Eyes section on the right-hand panel.

Step 2:
1. Choose the eyeshadow color and set its intensity using the Color intensity slider.
2. Adjust the brush size and its softness using the Brush size and Brush softness sliders.
3. Then paint along the eyelids to color them. You can use the Eraser to remove excess color. Tip: you can change color and its intensity after applying the effect.

Step 3: Click Apply to save the changes. To discard the changes, click Reset.

Movavi Picverse

**Mascara**

**How to apply the mascara effect to a portrait**

Step 1: Choose Mascara from the Eyes section on the right-hand panel.

Step 2: Set brush size and color intensity. Make sure that the brush diameter is slightly larger than eyelash length. Then paint along the eyelid to color in the lashes. Use the Eraser to remove excess color from the surrounding areas. Tip: you can change color and its intensity after applying the effect.

Step 3: Click Apply to save the changes. To discard the changes, click Reset.
Eyebrow pencil

How to color in the eyebrows on a portrait
Step 1: Choose **Eyebrow pencil** from the **Eyes** section on the right-hand panel.

Step 2:
1. Choose a color that matches the eyebrow color on your portrait and set its intensity using the **Color intensity** slider.
2. Set brush size and softness using the **Brush size** and **Brush softness** sliders on the right-hand panel.
3. Then paint along the eyebrows to color them.

Use the **Eraser** to remove excess color from the surrounding areas.
*Tip: you can change color and its intensity after applying the effect.*

Step 3: Click **Apply** to save the changes. To discard the changes, click **Reset**.
Lip color

How to change lip color in a portrait
Step 1: Choose Lip color from the Mouth section on the right-hand panel.

Step 2:
1. Choose a color you want and set its intensity using the Color intensity slider.
2. Set brush size and softness using the Brush size and Brush softness sliders on the right-hand panel.
3. Then paint along the lips to recolor them.

Use the Eraser to remove excess color from the surrounding areas.

Tip: you can change color and its intensity after applying the effect.

Step 3: Click Apply to save the changes. To discard the changes, click Reset.

Teeth whitening

How to whiten teeth in a portrait
Step 1: To open teeth whitening tools choose Teeth whitening from the Mouth section on the right-hand panel.
Step 2: Set brush size and color intensity on the right-hand panel. Then paint along the teeth to whiten them. You can adjust intensity after painting.

Step 3: Click Apply to save changes. To revert changes click the Reset button.

Movavi Picverse

Changing hair color

How to change hair color in a portrait

Step 1: Choose Hair color from the Others section on the right-hand panel.

Step 2: Choose a color, set its intensity and brush size and softness using the sliders on the right-hand panel. Then simply paint along the hair to color it.

Use the Eraser to remove excess color from the surrounding areas.

Tip: you can change color and its intensity after applying the effect.

Step 3: Click Apply to save the changes. To discard the changes, click Reset.
Face slimming

How to make face thinner

Step 1: Choose Face slimming from the Others section on the right-hand panel.

Step 2: The face recognition process will start automatically. Wait until you see the “Face(s) recognized successfully” message pop up on top of the image. If there are several faces in the photo, click the one you want to apply the effect. Click the Slim Down button on the right-hand panel.

Step 3: Drag the Intensity slider to adjust the effect.

Step 3: Click Apply to save changes. To revert changes click the Reset button.
Movavi Picverse

Reshaping tools

Step 1: Choose Reshaping tools from the Others section on the right-hand panel.

Step 2: Select one of the reshaping tools:

- Reshaping Brush - moves pixels with the movement of the brush. Click and hold on the object you want to reshape. Then drag the brush as if you were stretching the object.

- Shrinking Brush - moves pixels towards the center of the brush. Simply click on the object you want to shrink using this tool.

- Enlarging Brush - moves pixels away from the center of the brush. Simply click on the object you want to enlarge using this tool.

Step 3: Change the object's shape using the selected tool. You can adjust Brush size and Intensity for each tool.

Step 4: Click Apply to save changes. To revert changes, click the Reset button.
 Clone stamp retouching

How to remove small skin blemishes using the stamp tool

Located on the Smart Eraser tab, the Clone Stamp tool can help you manually correct small blemishes, remove wrinkles, or clone (copy) objects on an image.

**Step 1: Open the Smart Eraser tab**

Click the **Smart Eraser** icon to open the retouching options.

**Step 2: Select the Clone Stamp tool**

Click the stamp icon at the top to select the **Clone Stamp** tool.
Step 3: Set the stamp size and softness
Use the **Stamp size** slider beneath the tool icons to set the stamp's size. Increasing **Stamp softness** will make the stamp's edges more transparent, which can help you blend the stamped parts with the rest of the image.

![Stamp size and softness slider](image)

Step 4: Pick a source
Move your mouse pointer over to the area you want to clone (e.g., a similar area without blemishes). Hold down the ⌥ key and click on the image to define a source point.

![Pick a source](image)

Step 5: Paint over the target
Release the ⌥ key. Then, move your mouse pointer to where you want the cloned fragment to appear and paint over the area you want to replace. As you move your cursor while painting with the stamp, the sampled area will also move relative to your cursor position.

![Paint over the target](image)

Movavi Picverse

**Effects**

**How to apply effects to a photo**

On the right side of the window, click the **Smart Eraser** icon.
Step 2: Click on Popular to see the list of effect groups. Click on a group to open it and show the relevant effects.

Step 3: Choose an effect you like and click on it.

Step 4: For some effects, you can use the Intensity slider under the effect’s thumbnail to modify its strength or detail level. To apply an effect, click the checkmark button under the thumbnail.
Tip: You can apply multiple effects to one photo.

Removing effects
To remove an applied effect, click the cross button under the thumbnail or simply click on it once more.

Movavi Picverse

Crop and rotate

On the right side of the window, click on the **Crop and rotate** icon.

**Crop**
There are several ways to crop an image:

**Crop frame**
A crop frame will be visible over the image. Drag inside the image to draw the cropping rectangle, or move the crop frame edges with your mouse.

**Manual input**
If you need a specific size in pixels, you can manually enter the width and height into the corresponding boxes. To switch the width and height, click the **Invert Proportions** icon.

**Aspect ratio**
You can select a suitable aspect ratio size from the list. Here you can find some commonly used sizes and presets for quickly changing the proportions of the image.

**Lock aspect ratio**
Selecting this option will maintain the chosen width to height proportions. This way, when you change one dimension of the cropping rectangle (whether by drawing the cropping area or by entering a number for width or height), the other dimension will change accordingly to keep the selected aspect ratio. To lock aspect ratio, click the lock icon between the width and height boxes.
Rotate
Use the buttons on the Rotate and Flip tab to rotate the image by 90 degrees or to mirror the image.

- Rotates your photo 90° counterclockwise
- Rotates your photo 90° clockwise
- Flips your photo horizontally (left to right)
- Flips your photo vertically (upside-down)

Straighten images
The Straighten slider allows you to manually rotate the image up to 45° either way.

Auto Leveling
Click the Auto Leveling button to straighten the horizon automatically.

Level Tool
1. In your photo, find a straight horizontal or vertical line. It can be the horizon, the side of a building, or any other lines that are parallel or perpendicular to the horizon.

2. Now, click the Level Tool and trace that line on your image. Once you've traced the line, the image will be automatically rotated to make that line precisely horizontal or vertical.
Resizing images

How to change the size of an image

Tips:
If you intend to make other edits to the photo, do them before resizing it since the image quality will be preserved better. Also, we recommend that you save a copy of the image before resizing in case you need it later, especially if you plan on printing out the image.

Step 1: Go to the Resize tab

On the top panel of the window, click the Resize button to switch to the Resize tab.

Step 2: Enter new dimensions
Select or enter the necessary image size:
• To enter a custom image size, enter the dimensions into the width and height boxes. You can change the measurement unit in the box on top of the tab. The default unit is pixels.
• If you want to blow up your photo, select AI Enlargement. It will help you enlarge the photo without any quality loss.
• You can select a preset size from the Preset Sizes list.
• To avoid visual distortions of the image after resizing, keep the Keep aspect ratio option enabled.
Step 3: Apply changes
Finally, click **Apply** to resize the image to the specified size.

---

**Text**

**How to add text to a photo**

**Step 1:** Click the **Text** icon to switch to the **Text tab**.

**Step 2:** In the Text tab, click the **Add Text** button. A new text area will appear in the photo.

**Step 3:** Enter your text in the **Add Text** field.
Step 4: Set the font, size, and color for your text.

Step 5: Drag the text area with your mouse to place it inside the image. To rotate the text area or resize the text, drag at the resizing button in the bottom right-hand corner of the text area.

Step 6: Set the background and frame color, position of the text, and add a text warp if needed.
Click on the Decorations button to choose additional decorations from our library.

Removing text:

• Select a text area and click the button in its upper left-hand corner to remove just one caption.
• To remove all captions, click the Remove All Text button in the Text tab.

Tip: you can edit multiple objects at the same time. Press and hold Ctrl, then select the objects. To ungroup them, right-click on the group and select Ungroup object.

Movavi Picverse

Saving images

How to save an image in Movavi Picverse

Step 1: Click the Save icon button in the top right-hand corner or open the File menu and click Save to rewrite the previous image, or click Save As to save the image under a different name.

Step 2: You will see the saving window.
You can choose where the file will be stored in the Save as field. Click Browse to open Finder.

Choose the File type from the list.

The Show file in folder after saving option automatically opens the output folder in Finder after saving.

Step 3: Advanced settings (optional)

Click on the Advanced settings in the saving window to open the additional settings.

Here you can:

Add an author and a comment to your photo.

Select the Remove all metadata checkbox if you don't want the file to store any additional information.

Select the Remove GPS data checkbox if you don't want the photo to store any location information.

Step 4: Finally, click Save.

Movavi Picverse

---

**Changing image format**

**How to save images in different formats**

Step 1: After you've opened and edited an image, click the Save icon in the top right-hand corner of the window. The Save File dialog box will open.
Step 2: To choose an image format, open the **File type** box and select the format you need.

Some formats also allow you to set the image quality and compression method.

**JPEG Quality**
Drag the slider to the necessary quality level. Lower quality allows you to compress the image to smaller file size, but will probably not look as good.

**TIFF Compression**
Select the preferred compression method:
- **Uncompressed**: no compression method will be used. The image will be much larger in size than its compressed copies, but uncompressed images with large resolutions may be processed faster by some software.
- **PackBits**: offers less compression than LZW but is the most widely supported compression method, especially on Apple software.
- **LZW**: compresses the image to about half size.
- **ZIP**: best for working with 16-bit images and average for 8-bit images.

Step 3: Choose where to save the new file and give your file a name.

Step 4: Click **Save**.
If you make any edits after saving the file in a different format, you will be working with the new file.

**File information**

*Where to find file information*
To see a photo's media properties, go to the File menu, and choose File Information.
Or press the **File Information** button at the bottom of the window.

A **File Information** window will appear. Here you can find the file size, dimensions, format, and other properties of the original file. Knowing certain information about a file will allow you to better understand which settings are best for your photo.

**Image size and quality**

Even though image files rarely take up more disk space than videos or other media files, a large photo collection can quickly fill up your hard drive if you save all photos at the maximum size and quality. In this section, you will learn how to manage image file size.

The following properties define image file size:

**Image size in pixels**
The larger the image, the more pixels it will be made up of, and the more data will need to be stored. The number of pixels also defines image resolution for **printing** and affects the maximum level of detail you can achieve for a print of a specific size.

To reduce file size, you can **resize the image**. However, this comes at a cost: the smaller copy will look just as good, but if you want to print out the image or use it as wallpaper, the smaller file will look considerably worse than its original.
Let’s see how much disk space you can save by resizing images. Below are the file sizes for one image (here, you see a scaled-down preview), and the difference is impressive. Resizing a large image to a viewable 800x600 size makes the file size over a hundred times smaller.

<table>
<thead>
<tr>
<th>Dimensions</th>
<th>File Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>7899x5924 px</td>
<td>27,6 MB</td>
</tr>
<tr>
<td>800x600 px</td>
<td>168 KB</td>
</tr>
</tbody>
</table>

If you want to upload previews of your images to the web, or share photos in web albums, resizing the photos will most likely be a good idea. The upload will be faster, and if you have a storage limit, it won’t be filled up as fast as if you uploaded the images at their original size.

**Hint:**
Don't scale up small, low-quality images.

An image with small dimensions does not have enough data in the file to allow any program to fully restructure the quality of a larger size image. If you size them up, you will only be wasting disk space without any quality improvement.

Read our resizing guide

**Image complexity**

Image complexity plays a large role in file size. Due to image compression specifics, images with different content but identical size and format will differ in file size because of the details that will need to be preserved. For example, if you save a large image of a purely blue background, some compression methods will only need to store which color fills the whole image, while for a picture of a flower, all the small details will be stored to avoid quality loss.

Note the images below. They are of identical dimensions and are both saved in JPEG format. One image is a photo of a complex and colorful flower, while the other is a plain blue background. The second image’s file size, having to encode less data, is 48 times smaller than the first! And while you can’t simplify your photos to a single color, keep in mind that some images will naturally have a larger file size than others.

**Format and compression method**

A compression method can be seen as a shorthand writing system for image editing software, where it can write all the data of your image into less space, and then decipher the shorthand to recreate the image on your screen when you open the file. Most image compression methods do not store all of the image’s data pixel by pixel since it would take significantly more disk space. Instead, the image compression algorithm finds a way to pack this information by finding identical parts and only recording those same parts once, or by throwing away some data that it finds less important. Different formats have different compression methods, and choosing the best format largely depends on the type and purpose of the images.

**Lossless formats:** some formats can store the image without losing any data, meaning that the quality of the image will not decrease when you save it. These formats can store the image either at its full size or use a lossless compression method that will pack the image into a smaller file yet retain the original quality. No matter the compression level, these files are rather large but offer the benefit of higher quality and sharper images, which is especially important for text images and logos.

*Common lossless formats:* PNG, TIFF, BMP

*‘Lossy’ formats:* other formats allow you to save the images into smaller files, but they compress images at the expense of some quality. For large photos, the trade-off is usually justified, as the human eye will probably not notice the difference at low compression levels. However, when manually adjusting the quality of ‘lossy’ formats, such as JPEG, it is important not to set the quality too low to enjoy the image.

*The most common ‘lossy’ format:* JPEG

When you change an image’s format, note that saving it to a lossless format will not improve its quality, but only preserve the existing data. Likewise, if you change an image from a lossless format to a ‘lossy’ one, some data will inevitably be lost to compression.

Saving files in different formats

Movavi Picverse

**Printing images**
How to print images in Movavi Picverse

Printing the image
To print out an image from Movavi Picverse:
1. Open the File menu and choose Print.
2. Choose the printer you want to use for printing the photo.
3. Click Show Details to see more options, like paper size, orientation, and scale.
4. Choose the number of copies that you want to print. If this is your first time printing a photo, you may want to first print only one sample copy to make sure you have set up everything right.
5. Click Print to begin printing!

Image printing guidelines
Follow these guidelines to ensure the best possible print quality:

1. Make sure the image is large enough for printing on the selected paper size, and conversely, choose the right paper size for your images. If you print out small images on large paper, you may find that you can see individual pixels or that the image is not smooth enough on print. Before taking the photos you want to print, use a camera with a high megapixel count, make sure that it is set to the highest available quality (some cameras allow you to shoot smaller images than the camera's maximum size), and provide good lighting conditions to minimize noise.

The larger the original photo, the larger a print size you can afford without losing crispness and quality. The standard for printing images is to have at least 300 pixels per inch of the photo paper. The following table shows the correlation between image size and its printed size when printed at 300 pixels per inch (~118 pixels/cm). You can use it to match paper size to your image size and vice versa.

<table>
<thead>
<tr>
<th>Camera Megapixels</th>
<th>Image Size in Pixels</th>
<th>Printed Size in Inches</th>
<th>Printed Size in Centimeters</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>1600 x 1200 px</td>
<td>5&quot; x 4&quot;</td>
<td>13 cm x 10 cm</td>
</tr>
<tr>
<td>3</td>
<td>2048 x 1536 px</td>
<td>7&quot; x 5&quot;</td>
<td>17 cm x 13 cm</td>
</tr>
<tr>
<td>4</td>
<td>2464 x 1632 px</td>
<td>8.2&quot; x 5.4&quot;</td>
<td>21 cm x 14 cm</td>
</tr>
<tr>
<td>5</td>
<td>2560 x 1920 px</td>
<td>8&quot; x 6&quot;</td>
<td>21 cm x 16 cm</td>
</tr>
<tr>
<td>6</td>
<td>2816 x 2112 px</td>
<td>9&quot; x 7&quot;</td>
<td>24 cm x 18 cm</td>
</tr>
<tr>
<td>8</td>
<td>3264 x 2468 px</td>
<td>11&quot; x 8&quot;</td>
<td>28 cm x 21 cm</td>
</tr>
<tr>
<td>10</td>
<td>3872 x 2592 px</td>
<td>12.1&quot; x 9.1&quot;</td>
<td>33 cm x 22 cm</td>
</tr>
<tr>
<td>12</td>
<td>4000 x 3000 px</td>
<td>13&quot; x 10&quot;</td>
<td>34 cm x 25 cm</td>
</tr>
</tbody>
</table>

If you didn't find the necessary size in the table, you can easily calculate the printed size in inches by dividing the width and height in pixels by 300. Likewise, to find out the minimum number of pixels for a specific print size, multiply the width and height in inches by 300 to get the image dimensions in pixels.

2. You do not need to downsize the image before printing: the software will automatically fit the image onto the selected paper size. Decreasing the image will only reduce quality.

3. If you need to crop unwanted parts of the image, make sure that the result is not too small. If you have a very large image, you can use the crop function to zoom in on objects in the image, but keep in mind that the output image size must be large enough for printing. You can check the image size in pixels by clicking the File Information button on the bottom panel.

4. Use a high-quality printer for printing out your photos. These simple guidelines will help you choose a printer:
   - Inkjet printers are much better at printing images than laser printers. Dye sublimation printers are considered the best for printing photos, however, they are quite rare and can only be used for photo printing.
   - Check the printer's dots per inch (DPI) resolution: the higher the DPI, the higher the quality prints it will be able to produce. For photo printing, make sure that the printer has at least 300x300 DPI.
   - Generally, a dedicated photo printer will produce better results than a general-purpose multifunction printer of the same price range.
   - Some printers may produce colors different from the original because of the way they convert RGB color (the color scheme you see on your monitor) to CMYK color (used for printing).
   - Be aware of your printer's maximum print size; many consumer printers only print photos up to 8 by 10 inches (20.32 x 25.4 cm). You should find this information on the packaging or in the printer's user manual.

5. Use high-quality photo paper. There are different kinds of photo paper that may work differently depending on the content of your image. For example, glossy paper is better at reproducing bright colors, while matte paper is more suitable for portraits. Also, make sure that the paper matches your printer type (i.e., laser or inkjet).

Calibrating your display
The colors you see in print may be slightly different than those you see on your display due to LCD monitor specifics. You can try to calibrate your display for better previewing:
1. Open System Preferences.
2. Click the Display icon.
3. Switch to the Color tab.
4. Click the Calibrate button.
5. Follow the on-screen instructions to calibrate your display.
6. After completing the calibration name your profile to save the changes and click Finish.

Movavi Picverse

Program settings
To open the Movavi Picverse preferences, go to the Movavi Picverse menu and choose Preferences.
You will see the settings window. Here you can manage the following options.

**General settings**

- **Interface language** – to change the interface language, simply select the necessary language from the list and click **OK** to apply the changes.

- **Automatically check for updates** – select this option, and you'll be notified whenever a new version is available. Updates within your version are free (for example, 1.0 to 1.1), while new releases are offered with a hefty discount to registered users.

- **I give consent to send anonymous usage stats to Movavi** – checking this box will allow the program to send usage statistics to our development team, enabling us to fix any bugs you may encounter much faster, as well as add new features that you might be missing. The data contains no personal information, will not be disclosed to third parties and will be used for software improvement purposes only. [Learn more about how we use the statistics](#) [Read our Privacy Policy](#)

- **Save extended logs for troubleshooting** – in case you experience trouble using the program and contact our support team, they might ask you to collect logs. The logs contain the program's actions for some period of time, as well as important error reports and descriptions. Extended logs give the most amount of information, which may be essential to solving your problem.

**Files settings**

Directory for temporary files:

- Click **Browse...** to change the location of the temporary files.
Here you can set where to store temporary files that Movavi Picverse creates while working with your photos. Click Browse and choose a new folder for temporary files.
To go back to the default settings, click Reset.

Movavi Picverse

**Keyboard shortcuts**

For faster editing, the most commonly used actions are bound to shortcuts or hotkeys.

To open the list of shortcuts:
1. Open the Movavi Picverse menu.
2. Select Keyboard Shortcuts.

To change a shortcut:
1. Double-click the field next to the action you want.
2. Press the key or key combination you want to use.

![Keyboard shortcuts](image)

To reset all the keyboard shortcuts in a group to their original state, click the Reset icon.

Movavi Picverse

**Help and support**

Didn't find what you were looking for? Need help with a problem? Have a suggestion? Contact our support team, and we'll help you right away.

**How to reach us**

By email: support@movavi.com
Fill out a support form
We guarantee a response within 3 business days!

If you run into a problem, please describe it in as much detail as possible; any screenshots, log files, or information about your system will allow us to help you faster.

**Frequently asked questions:**

How to remove trial restrictions?
What are the system requirements for running Movavi Picverse?

Movavi Picverse

**Supported formats**

<table>
<thead>
<tr>
<th>Format</th>
<th>Input</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMP</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>DPX</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>EXR</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>GIF*</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>
### System requirements

The minimum system requirements represent the lowest hardware specifications that are guaranteed to run Movavi Picverse. If your computer meets the recommended configuration, then Movavi Picverse is sure to run smoothly on your computer.

<table>
<thead>
<tr>
<th>Minimum system requirements</th>
<th>Recommended configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Mac OS X® 10.10 and above</td>
</tr>
<tr>
<td>Processor</td>
<td>64-bit Intel® processor</td>
</tr>
<tr>
<td>Display resolution</td>
<td>1280x768, 32-bit color</td>
</tr>
<tr>
<td>RAM</td>
<td>2 GB</td>
</tr>
<tr>
<td>Available disk space</td>
<td>500 MB available hard disk space for installation, 1 GB for ongoing operations</td>
</tr>
<tr>
<td>Additional requirements</td>
<td>Internet connection, administrator permissions</td>
</tr>
</tbody>
</table>

**Movavi Photo Editor**

### Updating graphics card drivers

If you encounter an error message asking you to update your graphics drivers, you will need to download a new driver from your graphics card manufacturer’s website and install it on your system. Some graphics card drivers also have a useful utility that notifies you when a driver update is available and updates the driver automatically. Keeping your graphics card drivers up-to-date will ensure the stable performance of applications and games on your computer.

**Step 1: Find your graphics card manufacturer**

1. Right-click your desktop and choose **Screen Resolution**.
2. In the Screen Resolution settings window, click **Advanced settings**.
3. This will open your graphics card properties. At the top of the window, your graphics card model will be listed under the **Adapter Type** section. Note the full name of the graphics card somewhere for later.

**Step 2: Download the new version**

Now that you've learned your graphics card manufacturer and model, go to the manufacturer's website and find driver downloads. There, look for the model or series that you've found earlier and download the driver installation file. Some manufacturers may also offer a utility that will automatically find the necessary driver.

- **NVIDIA download center**
- **AMD download center**

**Warning:**

Only download drivers from the official manufacturer's website. Third-party websites offering driver downloads may contain malware.

**Step 3: Install driver**

Once the file is completely downloaded, run the installation file, and follow the onscreen instructions to install the driver on your system. Your display may blink several times in the process. After the installation has finished, it is advised that you restart the computer.
Updating NVIDIA® Driver
Modern NVIDIA graphics cards come with a special application called NVIDIA GeForce™ Experience that monitors driver updates and allows you to optimize your computer’s graphics performance.

1. Open the NVIDIA GeForce Experience application. It should already be installed on your system. If you cannot find the application, please try the method above.
2. In the Drivers section, click the Check for updates button to find the latest drivers.
3. When the application has found a newer driver, click the Download driver button. From here, the software will automatically download and install the necessary driver for your system.

Updating AMD® or ATI® Driver

1. If you have an AMD or ATI graphics card, go to the Driver Download Center on AMD’s official website. [AMD Driver Download Center]
2. Download the auto detect utility and run it when the download has finished. [Auto Detect Utility]
3. The utility will then automatically find your graphics card and help you download and install the right driver for your system.

   If the utility fails to find a driver for you, you can manually select your graphics card model and operating system on the Driver Downloads page and download the driver.

4. After the driver has downloaded, run the installation file and follow the on-screen instructions to install it.
5. After the driver has been installed, it is recommended that you restart your computer.

If none of the above steps have helped, feel free to contact our support team via email support@movavi.com or live chat.

If possible, please include the name of your graphics card model (see Step 1), as well as screenshots of any error messages you have encountered. This will help our support team specialists solve your problem quicker.

Movavi Picverse

How to collect logs
Providing your log files when you contact support can help us solve your problem faster. The logs contain the program’s actions for some period of time, as well as important error reports and descriptions. The log files do not contain any personal information.

Note that extended logs give the most amount of information, which may be essential to solving your problem. To save extended log files, go to General Preferences and check Save extended logs for troubleshooting.
Step 1: Find the logs
1. Click Go on the Finder menu bar.
2. Press on your keyboard. A hidden option 'Library' will appear on the list.
3. Click Library.
4. In the Library, go to Logs/Movavi.

Step 2: Send us the logs
1. Find the folder named picverse6.
2. Compress this folder and attach the archive to your email, support chat, or contact form when you describe your problem.